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Lesson 1 Drawing Tools 
 
This lesson assumes some familiarity with drawing tools in a graphics program such as 
Photoshop. The vector-based tools in Flash differ in significant ways, so those differences 
will be pointed out. You’re not expected to be a Photoshop expert. If you don’t recognize 
the names of the tools, roll your mouse cursor over the Tools panel (far left side of the 
Flash window) and pause on each tool: A label will pop up and show you the name of 
that tool. 
 
If you use Dreamweaver MX, the interface of Flash MX will look familiar to you, with the 
exception of the Timeline. If you have never edited digital video, the Timeline probably 
will be a new concept for you. If Flash is the first Macromedia application you have used, 
take some time to open the menus and look around. The Edit, Insert, and Modify menus 
will probably contain most of the unfamiliar items. 
 
Insert Figure 1.01a 
Caption: The Flash MX interface. 
 
Insert Figure 1.01b 
Caption: The Flash MX 2004 interface. The interface of Flash MX 2004 changed only 
slightly from the previous version, Flash MX. The five main areas are the same: 

1. The Tools panel allows selection of tools, view, colors, and options. 
2. The Timeline controls both motion and timing in the movie. 
3. On the Stage, you draw objects or drag them in from the Library. 
4. The Properties panel reflects what is selected on the Stage. 
5. Panels appear here after they are selected from the Window menu. 

[endCaption] 
 
Until you animate an object (in Lesson 2), you will not use the Timeline, except to 
delete your early experiments with the drawing tools. Locate the Timeline now anyway. 
It’s at the top of the Flash application window. 
 
Note: If the center area is empty and there’s no Timeline (nothing visible but gray), 
open the File menu and select “New.” That gives you a blank white Stage to work on. If 
the center area is filled with a menu that includes a list titled “Create New,” select “Flash 
Document” there, and you will get a blank white Stage. If you already have a white Stage, 
use that one. 
 
To the left of the Timeline is the Tools panel. The sixteen tools at the top are followed 
by icons that allow you to change the attributes of the selected tool. 
 
Below the Timeline is the Stage, a white rectangle on a field of gray. (The gray area is off 
stage, or out of sight, in the finished Flash movie.) Below the Stage is the Properties 
panel. Take a good look at that, because it’s going to change every time you select a tool, 
or an object on the Stage, and that can be confusing at first. 
 
To the right of everything else, you’ll see a stack of closed panels. Panels in Flash are the 
equivalent of palettes in Photoshop. They can be opened from the Window menu. If you 
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see the panel name but not the full panel, look for a small triangle widget to the left of the 
panel name, and click the widget once to open the panel (click again to close it). Panels 
can be undocked and dragged to different places, if you like to work that way. To undock 
a panel, move the mouse cursor to the left of the small triangle widget. When the cursor 
becomes a cross with four arrowheads, you can click and drag the panel to undock it, or 
move it out of the panel stack. You can also dock a floating panel by grabbing it that way. 
You will not use the right-side panels in this lesson. 
 

Lesson 1 
 
1. Open Flash and make sure you can see the Stage and also the Tools, Timeline, and 

Properties panel, which are described above. If they are not visible at all, find them 
on the Window menu. If you see the panel name but the panel is “closed,” then open 
the panel by clicking the small triangle widget to the left of the panel name. 

 
Insert Figure 1.02 
Caption: In the Document Properties dialog, notice the settings for: 

 Width 
 Height 
 Background color 
 Frame rate (in frames per second) 
 Ruler units (in pixels, naturally) 

These affect the entire Flash movie. 
[endCaption] 
 
2. In the Properties panel, select the size (in pixels) of your Flash movie. Here’s how: 

Click the Size button in the Properties panel and a dialog box opens. In the dialog 
box, set the width and height for the final Flash movie (this is the size at which it will 
appear in a Web browser window, just like a GIF or a JPG). You can also select a 
color for the background of the entire movie. Go ahead, try it. 

 
Of course you’re eager to get busy with the drawing tools, but make sure you 
understand what you’re doing here. You can change these settings at any time; 
however, it can be a big pain in the neck to change if you have already built a lot of 
things specific to this width and height. 
 
Also take note of the frame rate. If you have not edited video or film, working with 
time as a design element will probably be a little strange at first. All you need to know 
right now is that a frame rate of 12 (the default in Flash) means that 12 frames equals 
1 second (“fps” is “frames per second”). If you want a motion sequence to last 2 
seconds, at 12 fps it will need to span 24 frames in the Timeline. You definitely do 
not want to change the frame rate after you have built a lot of things in the movie! It 
would change the speed of everything in the entire movie. 
 
You’ll learn a lot more about frames in the Timeline—in Lesson 2. 

 
Insert Figure 1.03 
Caption: To change the stroke color for the Pencil tool, open the palette in the Properties 
panel after you have selected the tool. 
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3. Try out the drawing tools, starting with the Pencil tool. Click the tool in the Tools 

panel, then move your mouse cursor to the Stage. Click, hold, and drag. If you don’t 
see anything, that probably means your Pencil color is the same as your Stage color. 
You can change the Pencil color down in the Properties panel, which has changed 
to show you the current properties of the Pencil tool. 

 
Now that you’re looking at the Properties panel, you’ll see that you can also change 
the “Stroke height” (thickness of the line) and “Stroke style” (for example, make your 
pencil draw a dotted line). Go ahead, experiment with these properties by changing 
them and then scribbling with the Pencil tool. 
 
The Pencil tool also has three different modes for you to choose, but these are not on 
the Properties panel—they are on the Tools panel, near the bottom, under 
“Options.” Click to choose one, and scribble something. Select another mode, and 
scribble something similar. Compare all three modes to learn how they work. 
 
Now, here’s a very specific exercise to try with the Pencil tool:  
 

a) Select a “Stroke height” of 3 (in the Properties panel).  
b) Under “Options” on the Tools panel, select the “Smooth” mode. 
c) Draw a few hills or humps, all connected. 
d) Select the Arrow tool from the Tools panel. (The Arrow tool is used to select 

things on the Stage, and in fact, in Flash MX 2004, it is called the Selection 
tool instead—but it still looks and acts the same way.) 

e) Click on the Stage outside your humps, hold the mouse button down, and 
drag to select the complete drawing. Notice how an object has a dotted 
appearance when it is selected. 

f) Under “Options” on the Tools panel, select the “Straighten” mode. Watch 
what happens to the humps. Click the Straighten button several times and 
keep watching. 

 
Note:  To select things on the Stage, always use the black Arrow/Selection tool, on 
the left side of the Tools panel, unless otherwise directed. The white arrow-shaped tool 
is actually the Subselection tool, and it works differently from the (black) Arrow tool. 
In Flash MX 2004, the Arrow tool is called the Selection tool instead—but it still looks 
and acts the same. 
 
Insert Figure 1.04 
Caption: A rounded shape, drawn freehand with the mouse (top), can be straightened 
with a few clicks (bottom), using the “Straighten” mode in the Tools options. 
 
Insert Figure 1.05 
Caption: A rather lumpy leaf (left) can be smoothed with several clicks, and then 
straightened, to achieve a better result (right). 
 
4. Enough for the Pencil tool. You probably have a scribbled mess on the Stage that 

you would like to get rid of. Here is the one time in this lesson that you will use the 
Timeline. You can delete everything in a frame if you select that frame on the 
Timeline and then press the Delete key. You can see that there is only one frame 
(Frame 1, in fact) in your Flash movie, if you look closely at the Timeline. The black 
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dot and gray background symbolize that the frame has something in it. (If you have 
clicked the frame, the colors are white dot, black background. Click anywhere else to 
see the normal state of the frame, which is below the numeral 1, on Layer 1. A vertical 
red line goes through the frame.) 

 
Click that frame (with the black dot) once. That selects the frame. Press the Delete 
key on the keyboard. The Stage will become empty. The frame will be white, with a 
white (or empty) dot in it. Even though this is a very small thing, you will soon 
recognize that the appearance of frames in the Timeline is quite important. 
 
Remember that the black dot means there is something in the frame. The white dot 
means there’s nothing there. 

 
Insert Figure 1.06 
Caption: A single frame in the Timeline. 
 
5. Next you’ll try out the Brush tool. Click the tool in the Tools panel, move your 

mouse cursor to the Stage, click, hold, and drag. If you don’t see anything, that 
probably means your Brush color is the same as your Stage color. You can change the 
Brush color down in the Properties panel, which has changed to show you the 
current properties of the Brush tool. 
 
Unlike the Pencil tool, the Brush tool has size and shape attributes over in the 
Tools panel (even though it may seem that those should appear in the Properties 
panel). Change the “Brush Size” and make some more brushstrokes on the Stage. 
Change the “Fill Color” a few times. (Did you think the Brush would be governed by 
“Stroke Color”? Wrong, but an understandable mistake.) Change the “Brush Shape” 
and try that out. You can create neat-looking calligraphy with a little patience and the 
same smoothing effect you used with the Pencil tool above. 

 
One last trick with the Brush tool: 
 

a) Draw a closed shape, such as an oval. 
b) Change the “Fill Color.” 
c) Under “Options” in the Tools panel, select the Brush mode “Paint Inside.” 
d) Click the mouse inside your closed shape, keep holding the mouse button, 

and drag back and forth across the shape a few times. Go outside the lines 
(the way you never did in your childhood coloring books). 

e) When you release the mouse button, you’ll see the effect of the “Paint Inside” 
mode. 

 
Insert Figure 1.07 
Caption: The curlicue on the left was drawn freehand with the mouse, using the Brush 
tool. Select it with the Arrow/Selection tool, then click the Smooth button (under 
“Options” in the Tools panel) a few times, and you will get the result on the right. 
 
Insert Figure 1.08 
Caption: Painting outside the lines (left) is no problem with “Paint Inside” mode (right). 
The small black dot is the brush cursor. 
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6. That’s sufficient practice with the Brush tool. Empty the Stage now, just as you did 
in Step 4 above, by clearing Frame 1 in the Timeline. 

 
7. The most commonly used drawing tools in Flash are surely the Oval, Rectangle, 

and Line tools. You probably already have some idea of how these tools work 
individually, but you may not know how the shapes interact in Flash. So, make sure 
you have two different colors selected for Stroke and Fill, and then select the Oval 
tool. Click and drag on the Stage to draw a big oval. (If you’d rather draw a circle, 
hold the Shift key before you click, and keep holding it while you drag your shape.) 

 
With your oval (or circle) complete, click the Arrow/Selection tool. You’ll 
remember that you can click and drag with the Arrow tool to select a shape. You can 
also just click something to select it, and that can be very useful—as well as somewhat 
tricky, as you’re about to see. So click once on the outline of your oval. (After you 
click, the entire outline, or “stroke color,” should appear dotted, rather than solid.) 
 
Now click, hold, and drag the outline. This may surprise you: The entire outline 
comes away from the solid oval shape. Let go of the mouse button with the outline 
overlapping the solid fill. 
 

Insert Web site icon 
 
Select the smaller side of your solid oval and drag that. Yes, you have sliced up your 
shape. While this can seem maddening at first (if you are used to the bitmap drawing 
tools in Photoshop, for example), it turns out to be a great asset for creating neat-
looking shapes if you’re not very good at freehand drawing. In the illustration below, 
the almond shape on the right could be rotated 90 degrees to become a human eye 
(Modify menu > Transform > Rotate 90° CW). 

 
Insert Figure 1.09 
Caption: The behavior of the drawing shapes in Flash can be quite useful. Click any part 
of a shape once to select it. Once selected, it can be dragged away from the rest of the 
shape. 
 
8. If you aren’t used to using Ctrl-Z (or Cmd-Z/Mac) to undo, now is a good time to 

practice. Imagine that you never wanted to slice up your oval. You want to put it all 
back together again. Okay! Hold the Ctrl (or Cmd/Mac) key and press the letter Z. 
Repeat this until the oval has returned to its original complete state. By default, Flash 
lets you undo 100 steps. (You can change that to a maximum of 200, but doing so 
will tie up additional system memory.) 

 
9. If you want to move the entire oval shape, without breaking it into pieces, double-

click the inside part of the shape (the “fill color”). If everything appears dotted (both 
the fill and the stroke color), you can be sure you have selected everything. The shape 
can now be dragged as a single unit. If you make a mistake, Ctrl-Z! 

 
This is a good reason to drag with the Arrow/Selection tool to select a shape. 
When you drag a selection box around a shape, you can see exactly what you are 
selecting, and what you’re leaving out. 
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10. Let’s switch to the Rectangle tool and see how it differs from the Oval tool. (Keep 
your oval on the Stage, so you can use it later.)  Select the Rectangle tool. Click and 
drag on the Stage to draw a small rectangle. (If you’d rather draw a square, hold the 
Shift key before you click, and keep holding it while you drag your shape.) 

 
Click the Arrow/Selection tool to select it. Then click once on the outline of your 
rectangle. It’s important to click and let go (that selects the object), and then click, 
hold, and drag. When you did this for the oval in Step 7, the complete outline (stroke 
color) pulled away from the inside (fill color)—but for the rectangle, only one side of 
the outline pulls away. You could dismantle the rectangle outline in four parts, if you 
wanted to do that. 
 
Assuming you might want to move the entire outline away from the fill color, use 
Ctrl-Z (or Cmd-Z/Mac) now to restore your rectangle. This time, double-click any 
part of the outline of your rectangle. You should see all four sides appear dotted, 
showing that they are, in fact, selected. Once you see that, you can click and drag the 
complete outline away from the solid interior. 
 

11. There’s one more click-and-drag trick to master. If you click a side of the rectangle 
but do not let go of the mouse button, you can alter the shape by dragging. (You can 
do the same at a corner of the rectangle, but the result looks different.) Pay close 
attention to the mouse cursor when you click and hold, and you will see a clear 
indication of whether your dragging action will create a curve or an angle. The little 
shape that appears to the side of the cursor shows which one it will be. 

 
Insert Figure 1.10 
Caption: What happens when you click on the outline of a shape? 

A. A single click selects one side of a rectangle.  
B. A double click selects the entire outline (stroke color). 
C. Click and hold; look at the cursor.  
D. Drag without letting go.  
E. The shape can be changed by dragging on a side. 

[endCaption] 
 
12. Practice combining shapes to see how this capability in Flash makes it easier to 

create objects that look good, even if you lack real drawing talent. The first step is to 
make several shapes you want to combine into one. The second step is to drag the 
shapes into position. 

 
Note: The shape you select and drag will be on top of the other shape(s). Figure 1.11 
shows the result of dragging a small rectangle onto a larger circle. 

 
This next step is one of the vector drawing techniques that can be tricky to master—
but it’s infinitely useful, so it’s well worth the effort. While holding down the Shift 
key, click once on each line you want to remove from the final object. By “shift-
clicking,” you can add a lot of strokes (and fills too) to the selected state—that is, the 
state indicated by a dotted appearance. When you have selected everything you want 
to remove, press the Delete key once. 

 
Insert Figure 1.11 
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Caption: By combining shapes, you can produce objects that would be difficult to draw 
freehand. In the middle illustration above, shift-clicking three times has selected the 
three straight lines to be deleted. Notice that once a shape is on top of another shape, its 
outer lines will be broken up by the intersecting lines of the other shape. The illustration 
at right shows what one press of the Delete key can accomplish. 
 
13. Let’s do one last thing with the Rectangle tool, just because it can be useful, and it’s 

so simple. Empty the Stage now, just as you did in Step 4 above, by clearing Frame 1 
in the Timeline. Select the Rectangle tool. Look at the “Options” section of the 
Tools panel; you’ll see that the Rectangle tool has one option called “Round 
Rectangle Radius.” Click it, and you get the opportunity to set rounded corners for 
your rectangle object. The “100” setting produces the most rounding; it’s nice to use 
for oblong button shapes. The “20” setting produces a good-looking frame to enclose 
text. The “0” setting produces no rounding at all, or in other words, a normal 
rectangle with squared-off corners. You can change the thickness of the border 
(stroke color) at any time, even after you have drawn the rectangle—just double-click 
the border and change “Stroke Height” in the Properties panel. (The stroke 
thickness ranges from 0.1 to 10.) 

 
Flash MX 2004 Note:  
The Rectangle tool has two options in MX 2004; the second one is “Snap to Objects,” 
represented by a magnet icon. Click this when you want at least one edge of the rectangle 
to align perfectly over the edge of another shape on the Stage. (The Oval tool has this 
new option too.) Also, if you click and hold the Rectangle tool on the Tools panel, you 
get the option to use the new PolyStar tool, which draws a five-sided polygon shape. 
This is a fun tool, so be sure to try it. Use the Options button on the Properties panel 
before you draw to change the number of sides, or to select a star shape instead of a 
polygon. The PolyStar tool does not exist in earlier versions of Flash. 
 
14. You know enough now to experiment with the Line tool on your own, but here are a 

few ideas you may not think of right away. When drawing a triangle, for example, 
with the Line tool, you do not need to match the end of each line to the end of 
another. You can cross lines and extend them, then select and delete the excess part 
of any line (just as you did in Step 12 above, when you combined shapes). You will 
also find the Line tool useful for creating a half-circle, or a pie with a missing piece. 

 
Insert Figure 1.12 
Caption: Draw straight lines and then drag them into position on top of other shapes to 
cut away new shapes. 
 

Additional Tools 
 
Flash provides ten more tools. The Text tool will be discussed in detail in Lesson 9. The 
Eye Dropper, Lasso, Paint Bucket and Pen tools are not very different from the 
equivalent tools in Photoshop and similar software applications. The Eraser tool is easy 
to experiment with—draw something, and then try out the Eraser tool “Options” on the 
Tools panel. 
 
Try out the remaining four tools, which can be very useful: 
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 Fill Transform tool: If you have used a linear or radial gradient fill on a shape 

(see the Color Mixer panel), you can use this tool to move the point governing the 
direction of the gradient. 

 
 Free Transform tool: Select any shape with this tool, then scale, skew, or rotate 

the object by dragging the “handles” on the box. You can open the Transform panel  
(Flash MX: Window menu > Transform; Flash MX 2004: Window menu > Design 
Panels > Transform) to see numeric measures. Another option: On the Modify menu, 
go to “Transform” and select actions from the submenu to achieve many of the same 
effects. In other words, there are two other ways to transform an object, in addition 
to using the tool. 

 
 Subselection tool: Select the edge of any object with this tool to get access to 

anchor points, or draggable handles, that allow you to alter the shape of the object. 
For example, draw a square, then use the Subselection tool to reshape it into a skinny 
diamond shape. (This is quite useful in complex animation.) If you can’t get the 
shape you want with the Free Transform tool, then try this one. You can also use 
this tool to change a path you created with the Pen tool. 

 
Insert Figure 1.13 
Caption: Use the Subselection tool to change standard shapes into irregular shapes. 
 
 Ink Bottle tool: Use this tool to add an outline (of any color or thickness you 

choose) to an object without an outline. (If the object has an outline already, this tool 
simply changes the color of that outline.) The outline is called “stroke color” in Flash. 

 

Drawing Aids 
 

Snapping 
 
You may have encountered the “snap to” option in another software application, such as 
QuarkXPress. The option can be turned on or off. In Flash MX, there are two types of 
snapping available to you. Flash MX 2004 has additional options for snapping. All are 
available from the View menu. 
 
Snap to Objects, when enabled, makes a dragged object adhere to the edge of a second 
object (if you drag it close to the second object). It also works nicely with the Line tool in 
cases where you want a new line to start perfectly at the corner of an object. When you 
don’t want this option to operate, it can be extremely annoying—so learn how to turn it 
off! You can also enable and disable Snap to Objects from the Options (Tools panel) for 
some tools, such as the Arrow/Selection tool—look for the magnet icon. 
 
Snap to Pixels causes a precise pixel grid to appear if you set Magnification (on the 
View menu) to 400 percent or more. Each time you move an object or draw a new one, it 
adheres to the pixels (rather than allowing tenths of a pixel). 
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Aligning 
 
When you need to align objects with one another, you may be used to using guide lines 
(in Photoshop, for example). Flash provides guide lines (View menu), but the options 
available on the Align panel are far better! By selecting any number of objects on the 
Stage (shift-click each one), you can align them all by clicking one button on the Align 
panel. The farthest object in the direction you are aligning determines the alignment 
“edge.” For example, if you click “Align right edge” in the Align panel, all the selected 
objects will align with the right-hand edge of the right-most object selected. 
 
But wait, there’s more! You can also distribute the selected objects so they are equally 
spaced. This is especially useful for a row or column of related objects, such as thumbnail 
photos. Set the first and last objects where you want them, with all the other objects 
between them. Select all the objects, then click one of the six “Distribute” options. 
 

Grouping 
 
If you draw complex objects made up of several (or many) shapes, you may find it 
convenient to group some of the shapes, either temporarily or permanently. When a 
shape has been grouped, it will not cut other shapes (as described in Step 7 above). To 
group shapes that have been selected, press Ctrl-G (or Cmd-G/Mac), or open the Modify 
menu and select “Group.” All the selected shapes are now stuck together. 
 
Too much grouping can produce strange effects later when you animate an object, so it’s 
important to know how to ungroup also. Once the shapes are ungrouped, they will 
(again) cut into one another. To ungroup shapes that have been selected, press Ctrl-
Shift-G (or Cmd-Shift-G/Mac), or open the Modify menu and select “Ungroup.” All the 
selected shapes are now separate again. 
 
Insert Figure 1.14 
Caption: You should be able to draw all these shapes in Flash, regardless of your artistic 
skill (or lack thereof) by using the techniques described in this lesson. 
 

Drawing Tools Summary 
 
This should be enough information to set you on the path to working comfortably with 
the drawing tools in Flash. As with any software, the more time you spend playing with 
the tools, the better you will become at using them efficiently. As is also true of most 
software, you can accomplish quite a lot without learning how to use every tool. So don’t 
drive yourself crazy trying to use all the tools not discussed here. 
 
There are very good reasons to focus on these six tools initially: Arrow/Selection, 
Brush, Line, Oval, Pencil, and Rectangle. If you become comfortable with these, 
you will be able to accomplish most simple drawing tasks. 
 
Of course, Flash cannot turn you into an artist if you aren’t one already. But Flash will 
make it easy for you to create buttons, frames, pointers, and other simple objects. 
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If you are an artist, and you’re used to tools such as Illustrator or FreeHand, you may 
find Flash frustrating because it lacks features you depend on in those programs. You’ll 
be happy to know you can export Flash-compatible vector graphics from those programs 
(see Lesson 7).  
 

Conclusion 
 
In this lesson, you have learned to: 
 
1. Identify the Tools panel, Timeline, Stage, and Properties panel. 
2. Open and close panels. 
3. Specify the width and height (in pixels) of the final Flash movie. 
4. Select the background color for the entire movie. 
5. Check or change the frame rate for the entire movie. 
6. Identify all the items on the Tools panel. 
7. Use the Pencil tool, including stroke color, height, and style, and the options 

straighten, smooth, and ink. 
8. Use the Brush tool, including fill color and the options brush mode, size, and shape. 
9. Draw ovals and circles with the Oval tool. 
10. Draw rectangles and squares with the Rectangle tool. 
11. Draw straight lines with the Line tool. 
12. Use the Arrow/Selection tool to select objects (or parts of objects) in four ways: 

click and drag around the object, single-click, double-click and shift-click. 
13. Use the Arrow/Selection tool to alter the shape of an object (click the edge, hold, 

and drag). 
14. Use the Arrow/Selection tool to move selected objects (select first; then click, 

hold, and drag). 
15. Position a line, or other shape, in a way that slices another line or a solid fill—an easy 

way to create new shapes that are not ovals or rectangles. 
16. Combine objects to create new compound shapes. 
17. Use Ctrl-Z (or Cmd-Z/Mac) to undo up to 100 actions. 
18. Clear a frame in the Timeline by selecting it and then erasing everything it contains 

(Delete key). 
19. Snap objects to each other, or to a pixel grid. 
20. Align objects or distribute them evenly (Align panel). 
21. Group and ungroup shapes to make it easier to build complex objects. 
 
(end) 


